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About this Book
The BluePC user manual contains instructions on how to configure and use BluePC. It has the

following sections:

•  Chapter 1 Introduction – This section gives an introduction to BluePC, and describes the key

features.

•  Chapter 2 Installing BluePC – This section lists the minimum system requirements, and

describes the installation procedure.

•  Chapter 3 Getting Started – This section describes the elements of BluePC, the methods of

accessing BluePC, and the procedures for configuring BluePC preferences.

•  Chapter 4 Using BluePC – This section is a tutorial on how BluePC can be used to set up

wireless connections to access the network, browse the Internet, fax information.

•  Appendix – This section lists the supported OS, profiles, protocols, and icons used.

Document Conventions

This document uses the following conventions.

Appearance Description

Option Means that this is an option that needs to be selected.

Screen name Screen/dialog name

Means reader take note. Notes contain helpful suggestions or references to

material not covered in the guide.

Means caution. These are caveats to users that you need to be careful of the

response that you give, or the action that you perform. For example, if an

option is not selected the required action will not be performed.

It is a tip for saving time. Means the action describes an operation that the

reader can perform to save time.
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Chapter 1 Introduction

Impulsesoft's BluePC™ is a high-performance, versatile Bluetooth solution for Windows. It helps

end-users to seamlessly transition from a wired experience to a wireless experience. BluePC has been

certified for Bluetooth specification version 1.1.

BluePC™ enables a wireless connection between your computer and other Bluetooth devices. For

example, BluePC will help you:

•  Transfer files

•  Print information

•  Browse the Internet

•  Send or receive a fax

•  Synchronize mobile and hand-held computer devices

Every MS-Windows Legacy Application, be it Direct Cable Connection or Dial-up Networking or

NetMeeting, can now be used with the Bluetooth device connected to your computer.

Before you begin using BluePC, review the following terms that will be used through out the manual.

Term Definition

Bluetooth Address Unique identifier of a Bluetooth device.

Device Name This is the name used by BluePC to identify your device in the Bluetooth

Neighborhood.

Service Is the capability of a Bluetooth device through which the other Bluetooth

devices can access the Internet, local area network, or other resources.

Host The device that acts as a “source of services” and provides guests with the ability

to use these services.

Guest The device that utilizes services provided by the host.



BluePC User Manual

Installing BluePC 8

Chapter 2 Installing BluePC

2.1 System Requirements

This section lists the requirements that need to be met before you install BluePC.

•  Pentium class personal computer

•  64 MB RAM

•  16 MB of free disk space

•  Bluetooth Hardware

•  Windows 2000, Windows XP, Windows Millennium Edition, Windows 98 Second Edition

 Note:  The user needs to have administrator privileges on the system to install and

use BluePC.

2.2 Installing BluePC

1. Insert BluePC™ CD-ROM into the CD-ROM drive.

2. Execute the BluePC.exe file that is present on the BluePC CD-ROM. The Welcome window is

displayed.

Figure 1. Welcome screen
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3. Click Next. The License Agreement screen is displayed.

Figure 2. License Agreement

4. If you accept all the terms of the license agreement, click Yes to proceed. If you do not accept

all the terms of the license agreement, click No.

 Caveat: To continue installation, it is mandatory to agree to the terms of the License

Agreement.
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5. Click Next. The Choose Destination Location window appears.

Figure 3. Destination Folder
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6. By default, BluePC is installed in the Program Files\Impulsesoft\BluePC folder. To change

the destination folder, click Browse and select the required folder. Click Next to proceed. The

Installation Preferences window appears.

Figure 4. Installation Preferences



BluePC User Manual

Installing BluePC 12

7. Click Next to proceed. The Setup Status windows appears.

Figure 5. Setup Status

8. After all the files are copied, the following screen is displayed:

Figure 6. Digital Signature Not Found
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9. Click Yes. The Installation Complete screen is displayed.

Figure 7. Installation Complete

10. If you want to start using BluePC immediately, you need to restart your computer. Select the Yes, I

want to restart my computer now option and click Finish. Or, you can choose the No, I will

restart my computer later option and click Finish.

After you have restarted the computer, plug-in your Bluetooth device.
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If you are using a USB Bluetooth device and it has not been plugged in, the following screen is

displayed:

Figure 8. Getting Started

1. Locate the USB Port.

2. Plug in the Bluetooth device.
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If you are using a Bluetooth PC card and it has not been inserted, the following screen is displayed:

Figure 9.  Getting Started

1. Locate the PC card slot.

2. Plug in the Bluetooth device.



BluePC User Manual

Getting Started 16

Chapter 3 Getting Started

This chapter describes the following:

•  Accessing BluePC

•  Elements of BluePC

•  Setting BluePC Preferences

3.1 Accessing BluePC

You can access BluePC in more than one ways. The simplest way is to use the BluePC wizard, or the

 (Bluetooth icon) in the system tray. This section describes how you can access the various

elements of BluePC.

3.1.1 Post Installation

After you install BluePC and restart your machine, the BluePC Getting Started screen is displayed as

shown in the figure.

Figure 10. Getting Started
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Through this screen you can:

•  Discover BluePC - Click this option to view the user manual

•  Setup Preferences – Click this option to configure the BluePC preferences such as, device

name, accessibility, services offered by your device, file transfer, and business card options.

If you select the option Show this screen at startup, this screen is displayed every time you start

BluePC (at restart or Plug in of device). When you click Exit with Bluetooth device inserted in your

PC, the Bluetooth icon is displayed in the system tray.

Figure 11. Bluetooth Icon

Right-click the Bluetooth icon to view the menu. If you double-click on the icon, the Bluetooth

Preferences Wizard is displayed. Through this you can configure the BluePC preferences. Refer to

section 3.3 Setup Preferences on page 22 for more information.

If the Bluetooth device has not been inserted into you PC and you start your system, the Bluetooth

icon appears as shown in the figure below with the message:

Figure 12. Insert Bluetooth device

The message will disappear if you double-click the icon.

3.2 Elements of BluePC

BluePC comprises the following:

•  BluePC Wizard

•  Bluetooth-enabled Windows Explorer

•  Bluetooth Manager

•  BluePC Preferences

3.2.1 BluePC Wizard

The BluePC wizard helps you perform your tasks using Bluetooth. The wizard automatically

discovers the Bluetooth devices and the services offered by them. It presents the right choice of

device and service through which you can accomplish your task. Through the wizard, you can:

•  Browse the Internet
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•  Print files

•  Setup Preferences

To access the wizard, right-click the Bluetooth icon in the system tray and select BluePC Wizard.

Figure 13. Bluetooth Wizard menu

The following screen is displayed:

Figure 14. BluePC Wizard

Please refer to Chapter 4 Using BluePC on page 43, for details on how to print files or access the

network.
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3.2.2 Bluetooth-enabled Windows Explorer

The Bluetooth-enabled Windows Explorer is an enhanced Windows Explorer that allows you to

quickly discover other Bluetooth devices within the range, identify services, and configure the

required services as well. To access the Bluetooth-enabled Windows explorer, double-click the

Bluetooth Devices icon on your desktop or launch the Windows Explorer from the Start menu.

Figure 15. Bluetooth device icon

The following screen is displayed.

Figure 16. Bluetooth-enabled Windows Explorer
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You can also access Bluetooth devices through Windows Explorer. The Bluetooth Devices list

displayed in the left pane as shown in the figure below:

Figure 17. Bluetooth Devices

To search for Bluetooth devices in the vicinity, right click Bluetooth Devices and select the option

Search for Devices. You can also double-click the Search for devices icon in the right pane as

shown in Figure 17.

3.2.3 Bluetooth Manager

The Bluetooth Manager helps you organize the Bluetooth devices and services available. To access

the Bluetooth Manager:

1. Right-click the Bluetooth icon in the system tray. The following menu is displayed:

Figure 18. Bluetooth Manager Menu
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2. Select Bluetooth Manager. The following screen is displayed:

Figure 19. Bluetooth Manager

Bluetooth Manager remembers devices that you have discovered in the past. These devices are listed

by Bluetooth Manager in gray if they are not currently available. Click Delete under Bluetooth

Devices to remove an old device from the list. Click Delete under Service to remove the

corresponding setup in BluePC.

3.2.4 BluePC Preferences

Use BluePC Preferences to configure Bluetooth settings. When you use BluePC the first time after

installation, the BluePC Preferences wizard guides you through the process. You can access the

BluePC Preferences in the following ways:

•  Click the Setup Preferences option in the Welcome screen

•  Right-click the Bluetooth icon in the system tray and select the option Preferences
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•  Double-click the Bluetooth icon in the system tray

•  Double-click the BluePC Preferences icon in the Control Panel

•  Select the Setup Preferences option in the BluePC Wizard

Figure 20. Preferences

Refer to section 3.3 Setup Preferences on page 22 for more information on how to set preferences.

3.3 Setup Preferences

You need to configure your Bluetooth preferences before proceeding further. You can access the

Preferences screen in the following ways.

•  After you install BluePC and restart the machine, the Getting Started screen is displayed as

shown in Figure 10. Select the option Setup Preferences.

•  Double-click the Bluetooth icon in the system tray.

•  Right-click the icon and select the option Preferences from the menu.

•  Double-click the BluePC Preferences icon in the Control Panel

•  Select the Setup Preferences option in the BluePC Wizard
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3.3.1 BluePC Preferences Wizard

When you use the utility the first time after installation, the BluePC Preferences wizard guides you

through the various preferences that have to be set. Subsequently, this can also be invoked through

the Setup Preferences option in BluePC Wizard.

1. The BluePC Preferences Wizard welcome screen is displayed.

Figure 21. BluePC Preferences Wizard
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2. Click Next. The Bluetooth Device Name screen is displayed.

Figure 22. Bluetooth Device Name

3. Enter a name by which the local device will be identified. Click Next. The Select the Shared

Folder screen is displayed.

Figure 23. Select Shared Folder
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4. Select a folder on your system which can be accessed by other devices in the vicinity. Click Next.

The Select the Business Card screen is displayed.

Figure 24. Select Business Card

5. Select the business card that you would like BluePC to send to other Bluetooth devices. Click

Next.
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6. The Select the Inbox Folder screen is displayed.

Figure 25. Select Inbox Folder

7. Select the folder on your computer to store business cards and files received from other

Bluetooth devices. Click Next.

Figure 26. Final Screen
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8. The Final screen is displayed. Click Finish to complete the process.

Subsequently, when you access the Preferences option, the Preferences screen is displayed. It has

four tabs through which you can configure the preferences for your local device:

•  General

•  Services

•  Security

•  Advanced

3.3.2 General tab

Through this tab you can configure the properties related to the Bluetooth device on the computer.

This tab displays the following information:

•  Device Name

•  Bluetooth Address

Figure 27. General tab

1. You can enter a name for the local Bluetooth device for the other Bluetooth devices to identify

the local Bluetooth device.

2. In order to make your device accessible to other Bluetooth devices in the vicinity, you can select

the Make device visible to other Bluetooth devices.
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3. Click Apply to save the settings.

3.3.3 Services Tab

The Services tab is displayed as shown in the figure. You can add a service, which other Bluetooth

devices in the vicinity can use. Through this tab you can also remove a service.

Figure 28. Services tab

This tab displays the following information:

•  Name of the service

•  Brief description of the service

The following services are automatically offered:

•  Serial Port

•  File Transfer

•  Business Card Exchange

Double-click on a service to view it’s properties.
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Add a File Transfer Service

Using the File Transfer service you can exchange files with another Bluetooth device in the vicinity.

You need the service only if you would like other Bluetooth devices to access files on your computer

or to send files to your computer.

To add a File Transfer service:

1. Click Add. The Add Service dialog is displayed.

Figure 29. Add File Transfer

2. Select File Transfer from the Services list.

3. You can change the default description of the service.

4. By default the “share folder”, through which files can be transferred, is set to your default

directory in the My documents folder. Click Browse to select the path to the share folder.

5. Click OK to save the settings.

Add Business Card Exchange Service

Using the Business Card Exchange service you can send and receive business cards with other

Bluetooth devices in the vicinity. To enable the business card exchange service you first need to add

the service on your local device.
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To add a Business Card Exchange service:

1. In the Services tab click Add. The Add Service dialog is displayed.

Figure 30. Add Business Card Service

2. Select Business Card Exchange from the Services list.

3. You can change the default description for the service.

4. If you want to send a business card to a remote device, click Browse to select the path where

the business card is stored. If the option Send Business Card on Request is not selected

remote devices cannot “pull” your business card. If the option is selected, they can “pull” the

card from your machine.

5. By default, the business card that is “sent” by a remote system or pulled from a remote system is

stored in the path C:\Documents and Settings\<username>\My Documents. To change

the default path, click the Browse button and select the required path.

6. Click OK to save the settings.
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Add Serial Port Service

If your system is capable of offering a serial port service to other devices in the vicinity, you can add

the Serial Port service to Services list. To do so:

1. In the Services tab click Add. The Add Service dialog is displayed.

Figure 31. Add Serial Port Service

2. Select Serial Port from the Services list.

3. You can modify the default description.

4. Click OK to save the settings.
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Add Network Access Service

If your system has access to the network, you can offer a network access service to other devices in

the vicinity. This would help devices in using network resources. To add network access service:

1. In the Services tab click Add. The Add Service dialog is displayed.

Figure 32. Add Network Access Service

2. Select Network Access from the Services list.

3. You can modify the default description.
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4. Click OK to save the settings. The Digital Signature Not Found screen is displayed.

Figure 33. Digital Signature Not Found

5. Click Yes.

For other devices in the vicinity to access the network through your system, you need to configure it

accept incoming connections. To do so:

1. Click Start -> Programs -> Accessories -> Communications -> Network and Dial-up

Connections. The Network and Dialup Connections window is displayed.

Figure 34. Network and Dial-up Connections
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2. Double-click Make New Connection. The Network Connection Wizard is displayed.

Figure 35. Network Connection Wizard

3. Click Next. The Network Connection Type screen is displayed.

Figure 36. Network Connection Type
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4. Select the option Accept incoming connections. Click Next. The Devices for Incoming

Connections screen is displayed.

Figure 37. Devices for Incoming Connections

5. Ensure that only the option BluePC Network Modem for the Local Device is selected. Click

Next.
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6. The Incoming Virtual Private Connection screen is displayed.

Figure 38. Incoming Virtual Private Connections

7. Click Next. The Allowed Users screen is displayed.

Figure 39. Allowed Users
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8. If a user other than the Administrator or Guest needs to connect, you will need to add the user.

Click Add. The New User screen is displayed.

Figure 40. New User

9. Enter the details and click OK. Click Next to proceed. The Networking Components screen is

displayed.

Figure 41. Networking Components

10. Click Next.
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11. The Final screen is displayed.

Figure 42. Completing the Network Connection

12. Enter a name for the incoming connection. Click Finish to complete the process.

Users on the client side will now be able to connect to the LAN through BluePC.
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To remove a service:

Select the service in the Services tab and click Remove.

Figure 43. Remove Service

If you click Properties, the properties of the selected service will be displayed in a window.

Note: Any settings modified will be valid only for the next connection, and will be ignored
for the current connection.
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3.3.4 Security Tab

The Security tab is displayed as shown in the figure:

Figure 44. Security tab

1. Move the slider to set the security level (low or high) for your device.

a. Low security setting indicates that all devices in the vicinity will be allowed to connect to

your device and they do not need to provide password to connect

b. High security setting indicates that only trusted devices will be allowed to connect, and

untrusted devices will need to provide a password to connect

2. Therefore, when devices try to connect they are prompted with the following message:

Figure 45. Password Window
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3. If you choose a “High” security setting, you can specify devices that do not need to provide

password information. To do so, click Make Device Trusted.

Figure 46. High Security

4. The following screen is displayed.

Figure 47. Make Device Trusted

5. Select a device in the Restricted Devices list, and click the arrow to move the device to

Trusted Devices list.

6. Click Update to save the settings. You will be prompted for a password, one at a time, for each

device

7. Click Close to close the window.
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3.3.5 Advanced Tab

The Advanced tab is displayed as shown in the figure:

Figure 48. Advanced tab

1. Through this tab you can set the search options

•  Specify the number of seconds to search

•  Specify the number of devices to report

2. BluePC remembers Bluetooth devices that were found in the past. You can specify the

maximum number of days to keep devices in history.

3. Click Apply to save the information

You can obtain quicker results if you specify smaller values.
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Chapter 4 Using BluePC

This section describes how you can use BluePC to browse the web, access your network, fax

information, or synchronize your PDA with your PC. This section describes how to:

•  Access the Network

•  Transfer Files

•  Exchange Business Cards

•  Print Files

•  Synchronize PDAs with your PC

•  Send a Fax

4.1 Access the Network

You can create a connection to another computer or network thereby enabling applications such as

e-mail, browsing, and accessing the network resources. Setting up a network connection is a two step

process. You need to:

•  Locate a Bluetooth device offering network access

•  Set up Connection

4.1.1 Locate the Network Access Service

You can setup devices in the following ways:

•  Using the Access Network menu option in the Bluetooth menu

•  Using the BluePC wizard

•  Using the Bluetooth enabled Windows explorer

There are two methods in which you can access the network:

•  Through the Personal Area Network

•  Through the standard Dial-up network or LAN Access setup

Till a PAN connection is established, the PAN icon  in the system tray is displayed with a cross.
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Using the Bluetooth menu

1. Right-click the Bluetooth icon in the system tray and select Access the Network – >Make New

Connection.

Figure 49. Network Access menu

2. The BluePC Network Wizard screen is displayed. Click Next.

Figure 50. Network Connection Wizard
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3. The Network Connection Configuration screen is displayed with a list of devices through

which you can access the network.

Figure 51. Network Device Selection

4. Select the device and click Next. If you are accessing the network through a Personal Area

Networking service, you are directly connected to the network. And,  LAN connection icon

displays in the system tray as shown in the following figure:

Figure 52. LAN Connection in the system tray
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5. If you are accessing the network through a LAN or Dial-up connection., the Final screen is

displayed:

Figure 53. Complete Network Connection Configuration

6. If you check the option To connect to the Network immediately select this box and then

click Finish, the Digital Signature Not Found screen is displayed.

Figure 54. Digital Signature Not Found
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7. You will get this if you have not disabled “Digital Signature not Found” as explained in the

Appendix Disabling “Digital Signature Not Found”. Click Yes to proceed. The Network

Connection screen is displayed.

Figure 55. Network Login screen
8. Enter your network user name and password and click Dial. Click Finish to complete the

process.

If you have not checked the option as indicated in Step 6, you can connect to the network using the

procedure described in section 4.1.2 Set up Connection on page 53.

Using BluePC Wizard

1. Right-click the Bluetooth icon in the system tray and select the option BluePC Wizard.

Figure 56. Bluetooth Wizard menu
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2. The BluePC Wizard welcome screen is displayed.

Figure 57. BluePC Wizard welcome screen
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3. Click Next. The BluePC Wizard option screen is displayed.

Figure 58. Access the Network option

4. Choose Access the Network. The steps that follow to setup the network access are the same as

described in the previous section Using the Bluetooth menu on page 44.
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Using the Bluetooth-enabled Windows Explorer

If you know the Bluetooth device offering network access, use the Bluetooth-enabled Windows

Explorer to access the network.

1. Double-click the Bluetooth Devices icon on your desktop (You may also right-click the

Bluetooth Devices icon and select the option Search for Devices). The following screen is

displayed:

Figure 59. Bluetooth Devices screen

2. Double-click the Search for Devices icon. The Explorer searches for devices in the vicinity.
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3. Select the required device and double-click Obtain Services.

Figure 60. Obtain Services

4. The services offered by the selected device is listed.

5. If you are accessing the network through a Personal Area Network service, you are directly

connected to the network. And,  LAN connection icon displays in the system tray as shown in

the following figure:

Figure 61. LAN Connection
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6. If you are accessing the network through a LAN or Dial-up connection, double-click the

Network Access icon to connect to the service. The following screen is displayed.

Figure 62. Digital Signature not Found

7. Click Yes. BluePC connects to the device offering the service and displays the status

Service Mapped in the Status field.

Figure 63. Service Mapped
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4.1.2 Set up Connection

The network connection window is automatically launched once the service is set up. Later on, you

can access the connection through the system tray or through Bluetooth-enabled Windows explorer.

To access the connection through the system tray:

If you have connected to a Personal Area Network service:

1. Right-click the Bluetooth icon and select the option Access the Network. The Network Access

services that you have configured are displayed as shown.

Figure 64. Network Access Menu

2. Click the select the required service. You are directly connected to the network, and the LAN

connection icon displays in the system tray as shown in the following figure:

Figure 65. LAN Connection
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3. You can also see the status using Network and Dialup connections. The window displays the

Connected status.

Figure 66. Network and Dial-up Connections

If you have connected to a LAN access service or Dial-up networking service:

1. Right-click the Bluetooth icon and select the option Access the Network. The Network Access

services that you have configured are displayed as shown.

Figure 67. Access Network Menu
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2. Click to select the required service. The corresponding log in screen is displayed. For example, if

you are connecting to a Network Connection the following screen is displayed.

Figure 68. Network Log in screen

3. Enter your network user name and password and click Dial.

Once you have established the connection you are a part of the Local Area Network (LAN). Now,

you can browse the Internet, share and access resources from the LAN, and use the printer resource

available in the LAN. For data transfer using the Network Access service, the user who has logged

into the system acting as the LAN gateway should have permissions to access the domain on which

the machine is connected, and administrator privileges on the machine acting as the LAN access

gateway.

To access the connection through the Bluetooth-enabled explorer:

1. In the Windows Explorer screen, double-click the service that you have configured (you may

also right-click the service and select the option Connect). The corresponding login screen is

displayed
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1. For example if you are connecting to a Dial-up Networking service the following screen is

displayed:

Figure 69. Dial-up connection

2. Edit your Internet Service Provider username and password. Click Connect.

3. Once you establish a connection the following icon is displayed in the system tray with a

message.

Figure 70. Dial-up Connection icon in System Tray
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4. You can also see the status using Network and Dialup connections. The window displays the

Connected status.

Figure 71. Connected Status

5. Now that you have established a Dial-up networking connection, you can browse the Internet.

6. To disconnect the connection, right-click the icon in the system tray and select the option

Disconnect. The icon disappears from the system tray and Network and Dial-up

Connections window will display the Disconnected status.

Figure 72. Disconnected Status
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4.2 Transfer Files

BluePC allows you to browse folders and copy, move, or delete files on a remote Bluetooth enabled

system. You can transfer files in the following ways:

•  Using the Transfer File menu option

•  Using the Bluetooth-enabled Windows Explorer

4.2.1 Using the Transfer File Menu Option

Send Files

1. Right-click the Bluetooth icon in the system tray and select the option Transfer File -> Send

File.

Figure 73. Send File menu

2. The File Selection screen is displayed. Click Browse to select the required file.

Figure 74. File Selection

3. Click Next to proceed.
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Next, you need to select the remote device to which you want to send the file. Select the required

device and click OK.

Figure 75. Select device

4. The file is sent to the shared folder of the remote device.

Receive Files

1. Right-click the Bluetooth icon in the system tray and select the option Transfer File -> Receive

File.

Figure 76. Receive File Menu
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2. The Device Selection window is displayed.

Figure 77. Device Selection

3. Select the device and click Next. The File Selection screen is displayed.

Figure 78. Receive File
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4. Click Browse. The Receive File screen is displayed.

Figure 79. Receive Files

5. Select the required file and click Select. In the File Selection screen, click Receive.

6. When the file has been copied to your shared folder, click Finish to close the screen.

Caveat: If someone wants to send you a file or copy a file to your system or delete
a file from your system, a prompt is displayed asking you whether you want to
allow the operation. You have the option of rejecting or accepting the operation. If
either option in this pop-up window is not exercised within 10 seconds, the
operation will be rejected and this window will disappear. If you select the option
“Do not ask me again” all the above operations will be performed, for the remote

device, without prompting you again.

Figure 80. Security Prompt

4.2.2 Using the Bluetooth-enabled Windows Explorer

You can use the Explorer to transfer files between two Bluetooth devices. To do so:

1. In Windows Explorer double-click the Bluetooth Devices icon. The devices are displayed in

the right-pane. Double-click the required device.
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2. Double-click the device name to view the services offered. The services are listed as shown in

the figure. Double-click the File Transfer icon (you may also right-click the File Transfer icon

and select the option Open).

Figure 81. File Transfer menu

3. The contents of “shared folder” of the selected device is displayed.
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4. Right-click a file on the remote device.

Figure 82. File Transfer option

5. You have the following options:

•  To move a file, select the option Cut. Select the destination location and Paste it there.

•  To copy a file, select the option Copy and Paste it in the destination location.

•  To send a file to your shared folder select the option Send To -> My Shared Folder.

The selected file is copied to the shared folder on your system

•  If you have required permissions you can also delete a file in the remote Bluetooth

device.
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6. If you right-click a file on your system the following screen is displayed.

Figure 83. Send to option

7. You have the following options:

•  To move a file, select the option Cut. Select the destination location and Paste it there.

•  To copy a file, select the option Copy and Paste it in the destination location.

•  Send To -> Bluetooth Devices (Refer Step 8)

8. To send a file to a Bluetooth device directly, select the option Send To -> Bluetooth Devices.

The Send File screen is displayed.

Figure 84. Send File

9. Select the device to which you want to send the file. Click Send. The file is transferred to the

shared folder of the selected device.
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10. You can also drag and drop files. Select the required file on your system and drag and drop it in

the shared folder of the remote device. Or select a file in the shared folder of the remote device,

and drag and drop it  into a folder on your system.
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4.3  Exchange Business Cards

BluePC allows you to send or receive business cards between your computer and other Bluetooth

enabled devices.

4.3.1 Send Business Cards

1. Right-click the Bluetooth icon in the system tray and select the option

Exchange Business Card->Send.

Figure 85. Send Business Card menu

2. The Exchange Business Card dialog is displayed

Figure 86. Exchange Business Card

3. Select the device to which you want to send the business card. Click OK.
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4. The business card is sent to the remote device. The Business Card Exchange dialog displays

the status of the business card exchange.

Figure 87. Send Business Card progress bar

4.3.2 Receive Business Cards

To receive business cards from a remote device:

1. Right-click the Bluetooth icon in the system tray and select the option

Exchange Business Card->Receive.

Figure 88. Receive Business Card menu

2. Select Receive. The Exchange Business Card screen is displayed.

Figure 89. Exchange Business Card

3. Select the device from which you want to receive a business card. Click OK.
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4. The Business Card Exchange dialog displays the status of the business card exchange.

Figure 90. Receive Business Card progress bar

You can exchange Business cards through the Bluetooth-enabled Windows Explorer.
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4.4 Print Files

You can set up the printing service through the BluePC wizard or through the Bluetooth-enabled

Windows Explorer.

4.4.1 Using BluePC Wizard

To set up the printer:

1. Right-click the Bluetooth icon in the system and select the option BluePC Wizard.

Figure 91. Bluetooth Wizard menu option
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2. The BluePC Wizard welcome screen is displayed. Click Next.

Figure 92. Bluetooth Wizard welcome screen

3. A list of options is displayed. Select Print Files and click Next.

Figure 93. Print Files option
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4. The BluePC Printer Wizard dialog is displayed. Click Next.

Figure 94. Add Printer Wizard

5. BluePC automatically discovers all the devices in the vicinity offering a printing service and lists

them in the dialog.
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Figure 95. Printer selection

Caveat: BluePC Wizard will display only those printers that provide Bluetooth
Hardcopy Cable Replacement feature

6. Select the required printer. Click Next.

7. The Final screen is displayed. Click Finish to complete the process.

Figure 96. Final screen
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Now, use any Windows application with the Print option to print files. The printer that you have

configured is added to the list of configured Printers. For example, if you are printing a Word file

select the printer that you have configured.

Figure 97. Printer Selection
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4.4.2 Using Bluetooth-enabled Windows Explorer

1. In Windows Explorer double-click the Bluetooth devices.

Figure 98. Explorer Devices

2. Double-click the device offering the printing service. The Printing service icon is displayed in

the right-pane.

Figure 99. Printer service
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3. Double-click the Hardcopy Cable Replacement service to connect to the printing service.

Figure 100. Service Mapped

The status Service Mapped is displayed. Now, use any Windows application with the Print option

to print files. The printer that you have configured is added to the list of configured Printers.

4.4.3 Print to a Standalone Printer

You can print to a standalone printer offering Serial Port service. To do so, you need to do the

following:

•  Setup the Bluetooth Enabled Printer

•  Access the Serial Port Service on your computer

Setup the Bluetooth-Enabled Printer

The Bluetooth printer needs to offer a Serial Port Service. Please refer to the printer’s user manual

for instructions on how to setup the printer to offer a Serial Port Service.

Access the Serial Port Service

On your computer you first need to locate the Serial Port service offered by the printer.

To locate the service:

1. The Bluetooth-enabled Windows Explorer displays all the Bluetooth devices within the vicinity

along with a list of services provided by them.
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Figure 101. Bluetooth-enabled Windows Explorer

2. Select the printer that is offering the Serial Port Service from the list of displayed devices.

3. Double-click the Serial Port Service to connect to the service. Let us say that the COM port

through which you are connected is COM 7.

Note: COM 7 is for illustration purposes only. You can be assigned any other COM port in
your case.

Next, you need to setup a printer connection so that print jobs can be directed to the printer.

To setup the printer connection:

1. Click Start and select the Settings -> Printer option.

Figure 102. Printers
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2. The Printers screen is displayed. Double-click Add Printer. The Add Printer Wizard is

displayed.

Figure 103. Add Printer Wizard

3. Click Next to proceed.

Figure 104. Local or Network Printer
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4. The Local or Network Printer selection screen is displayed. Select the Local Printer option

and click Next.

Figure 105. Select Printer Port

5. The Select Printer Port screen is displayed. Select the port through which you have connected

to the Serial Port Service, namely COM 7. Click Next.

Note: COM 7 is for illustration purposes only. You can be assigned any other COM port in
your case.

Figure 106. Name your Printer
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6. The Printer Name screen is displayed. Enter a name. If you want to set this printer as the

default printer, click the Yes radio button. Click Next.

Figure 107. Printer Sharing

7. The Printer Sharing screen is displayed. Select the option Do not share this printer, and click

Next.

Figure 108. Print Test Page

8. The Print Test Page screen is displayed. If you want to print a test page, select the option Yes

and click Next. Else, select the option No and click Next.
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Figure 109. Final Printing Setup screen

9. The Final screen is displayed. Click Finish to complete the process.

Now, use any Windows application with the Print option to print files. When you select the Print

option in a Windows application, ensure that you select the printer that you have installed.
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4.5 Synchronize PDAs with your PC

With this scenario, you can synchronize your PDA with your PC to get your appointment calendar,

or Emails.

To synchronize your PDA with a PC, you need to:

•  Add a Serial Port Service

•  Setup the PDA to use the Serial Port Service

•  Synchronize your PDA using the synchronization application

4.5.1 Add a Serial Port Service

You can add a serial port using the Bluetooth Configuration Manager. Refer to the section Add Serial

Port Service for more information.

Let us say that the port the service is subscribed to is COM 8.

 Note: COM 8 is for illustration purposes only. You can be assigned any other COM port in
your case.

4.5.2 Setup the PDA to use the Serial Port Service

Refer to the respective PDA user manual for instructions on how to use the synchronization service,

such as ActiveSync, over the Serial Port offered by the Bluetooth-enabled PC.

4.5.3 Synchronize your PDA

Synchronize your PDA using ActiveSync

To synchronize the PDA with the PC:

1. Double-click the ActiveSync icon  in the system tray on your laptop. The ActiveSync screen

is displayed.

2. Select the option File -> Connection Settings from the main menu. The Connection Settings

screen is displayed.
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Figure 110. ActiveSync Connection Settings

3. Select the option Allow serial cable or infrared connection to this COM port:, and select

the Serial Port to which you have subscribed the service. In this example, it is COM 8. Click OK.

You have now configured ActiveSync to use the required port.
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Now, to synchronize the PDA:
1. From the PDA, select the required synchronization option. The PDA connects with the PC.

Figure 111. Connection Established

2. Once the connection is established the synchronization progress screen is displayed on your PC.

Figure 112. Synchronization Complete

3. Once the synchronization is complete, Synchronized status is displayed in the ActiveSync screen.
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Synchronize your PDA Using Hotsync

To synchronize the PDA with the laptop:

1. Right-click the Hotsync icon in the system tray  on your laptop.

Figure 113. Hotsync Menu

The HotSync menu is displayed. Select the option Setup.

Figure 114. Synchronization setup

Select the Serial Port to which you have subscribed the Serial Port Service. In this example, it is

COM 3. Click OK.

Note: COM 3 is for illustration purposes only. You can be assigned any other COM port in
your case.

You have now configured HotSync to use the required port.
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Now, to synchronize the PDA:

1. Press the HotSync button on your PDA cradle. This button has two arrows pointing towards

each other.

2.  If this the first time you are doing a HotSync, enter a user name in the New User dialog box and

click OK.

3. The HotSync dialog box will appear, and will you show you the synchronization progress.

Wait for a message on your PDA indicating that the synchronization is complete. Then, you can

remove the PDA from the cradle.
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4.6 Wireless Conferencing scenario

With this scenario, you can exchange information with friends and colleagues, to collaborate on

projects, teach a class, and give presentations wirelessly.

4.6.1 Setup the Host Computer

The first step is to add a Serial Port service on the host computer. Please refer to the section Add

Serial Port Service on page 31 for more Information.

Next, you need to setup a Direct Connection. Let us say that the COM port assigned is COM 7. This

will be needed to setup Direct Connection.

Note: COM 7 is for illustration purposes only. You can be assigned any other COM port in
your case.

To set up a connection:

1. Click Start and select the Programs > Accessories > Communication > Network and Dial-

up Connections option. The Network and Dial-up Connections screen is displayed.

Figure 115. Network and Dial-up Connections Window
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2. Double-click Make New Connection. The Network Connection Wizard displays.

Figure 116. Network Connection Window

3. Click Next to proceed. The Network Connection Window is displayed.

Figure 117. Network Connection Type
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4. Select the Accept incoming connections option. Click Next. The Choose Role screen is

displayed.

Figure 118. Choose Role

5. Select the Host option. Click Next. The Connection Device screen displays.

Figure 119. Connection Window

6. Select the same communication service (COM 7). Click Next. The Allowed Users screen is

displayed.

 Note: COM 7 is for illustration purposes only. You can be assigned any other COM port in
your case.
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Figure 120. Allowed users

7. Click the checkbox to select the users who are authorized to use the direct cable connection.

Click Next. The Final screen is displayed.

Figure 121. Incoming Connection Name

8. Enter the required name and click Finish to complete the process.

A new network connection link is created in the Network and Dial-up Connection explorer with

the name Incoming Connection. The connection type and connection status is also displayed adjacent to

it.
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Next, you need to start a NetMeeting session on the host computer.

1. Click Start > Programs > Accessories > Communication > NetMeeting. A NetMeeting

window appears as shown by Figure 122.

Figure 122. NetMeeting

Do not close the NetMeeting window until you wish to allow other Bluetooth devices to connect

over NetMeeting.

4.6.2 Set up the Guest Computer

To setup the guest computer, which is your computer, you first need to access the Serial Port service

offered by the host computer.

To locate the service:

1. The Bluetooth-enabled Windows Explorer displays all the Bluetooth devices within the vicinity

along with a list of services provided by them.
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Figure 123. Bluetooth-enabled Windows Explorer

2. Select the host computer that is offering the Serial Port Service from the list of displayed devices.

3. Double-click the Serial Port Service to connect to the service. Let us say that the COM port

through which you are connected is COM 7.

Note: COM 7 is for illustration purposes only. You can be assigned any other COM port in
your case.

Next, you need to setup a direct connection with the host computer, which is offering printing

resources.
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To setup a direct connection with the host computer:

1. Click Start and select the Programs > Accessories > Communication > Network and Dial-

up Connections option. The Network and Dial-up Connections screen is displayed.

Figure 124. Network and Dial-up Connections

2. Double-click Make New Connection. The Network Connection Wizard is displayed.

Figure 125. Network Connection Window
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3. Click Next to proceed. The Network Connection screen is displayed.

Figure 126. Network Connection Type

4. Select the Connect directly to another computer option. The Choose Role screen is

displayed.

Figure 127. Choose Role
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5. Select the Guest option. Click Next. The Connection Device screen is displayed.

Figure 128. Connection Window

6. Select the same communication port to which you have subscribed this service (COM 4). Click

Next. The Connection Availability screen is displayed.

Figure 129. Connection Availability
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7. Select the For All Users option. Click Next. The Final screen is displayed.

Figure 130. Direct Connection name

8. Enter a name for the connection, and click Finish. The Connect Direct Connection screen is

displayed.

Figure 131. Connection Window

Enter the user name and password as specified by the host computer and click Connect. In case

“Guests” are allowed to connect, user name and password will be blank.
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Next you need to start a NetMeeting session on the guest computer.

1. Click Start > Programs > Accessories > Communication > NetMeeting. A NetMeeting

window appears as shown by Figure 132.

Figure 132. NetMeeting

2. Click Call > New Call. The following dialog box appears.

Figure 133. Place a Call

3. Enter the address of the person to call.

4. Select the relevant address.

5. Click Call button. The following message box appears.

Figure 134. NetMeeting Status
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Once the host computer (the computer that you have called) accepts the call, the message box

disappears. The NetMeeting dialog box displays the user name of the host computer in the Name

field as shown by Figure 135.

Figure 135. NetMeeting Ready

Now you can correspond on any of the NetMeeting tools like; chat, whiteboard, and file transfer.

The following section describes how to chat and use whiteboard in NetMeeting. For the complete

information on how to use NetMeeting, refer to NetMeeting Help.

4.6.3 Use an already setup Wireless Conference Scenario

Every time you need to use the NetMeeting service, you need to setup both host and guest as given

in the previous sections.

To chat on NetMeeting, do the following:

1. Click on the relevant person name you need to chat in the Name field.
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2. Click Tools > Chat. The following dialog box appears.

Figure 136. Chat Session

3. Enter your message in the Message field. Click File > Send Message.

To use Whiteboard, do the following:

1. Click on the relevant person name you need to collaborate in the Name field.

2. Click Tools > Whiteboard. The Whiteboard appears as shown by Figure 137.

Figure 137. Whiteboard Session

You can now collaborate in real time with others via graphic information.
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4.7 Send a Fax

You can send a Fax to a Bluetooth-enabled Fax machine, or to Bluetooth Mobile Phone. To send a

Fax you first need to locate a device offering the Fax service. To do so:

1. In the Bluetooth-enabled Windows explorer double-click the Bluetooth Devices icon. All the

devices in the vicinity are listed.

2. Double-click Obtain Services. The services offered by the device are listed.

Figure 138. Explorer Services
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3. Double-click the Fax service icon. The following screen is displayed.

Figure 139. Digital Signature not found

4. Click Yes. BluePC connects to the service and the status Service Mapped is displayed in the

Service field.

Figure 140. Service mapped

5. To connect to the service, right-click the Fax service icon and select the option Connect.
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You would need a Fax client software such as WinFax PRO for using fax. This can be obtained from

www.symantec.com/winfax. The steps that follow describe the procedure for configuring the Fax

setup using WinFax Pro.

1. Start WinFax. Select Tools > Program Setup from the menu.

2. Select Modem & Communication Devices and click Properties. The Modem and

Communication Properties screen is displayed.

Figure 141. Modem and Communications Devices Properties

3. Select the checkbox that corresponds to the configured Fax. The following message is displayed.

Figure 142. WinFax Confirmation Prompt

 Note: This Modem name “BluePC Fax Modem for Francolin” is for illustration purposes
only. The actual Modem name might be different in your case.
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4. Click Yes. The Modem Configuration screen is displayed.

Figure 143. Modem Configuration Wizard

5. Click Next. The Setup tests and verifies the modem. On completing the query the following

screen is displayed.

Figure 144. Testing Modem
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6. Click Next to proceed. The Final screen is displayed.

Figure 145. Final Screen

7. Click Finish to complete the configuration process.

To send a Fax:

In the WinFax Pro screen click Send. The following screen is displayed:

Figure 146. Send a Fax

Type the information and click Send.
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4.8 Listen to Music

Note: This feature is available only if you are using a PC card.

To set up an audio gateway, you need to:

•  Setup the headset

•  Setup your computer as a audio gateway

To setup the headset, refer to the Headset user manual.

4.8.1 Setup your Computer as a Audio Gateway

You can setup your computer as an audio gateway in the following ways:

•  Using the BluePC menu

•  Using the BluePC Wizard

Using the BluePC menu

1. Right-click the Bluetooth icon in the system tray and select the option Listen to Audio -> Make

New Connection.

Figure 147. Bluetooth Wizard menu option
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2. The BluePC Audio Wizard welcome screen is displayed. Click Next.

Figure 148. Bluetooth Wizard welcome screen

3. Click Next.
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4. The BluePC Audio Wizard automatically discovers the audio devices in the vicinity and displays

them in the dialog.

Figure 149. Select the Headset

5. Select the required device and click Next.
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6. The Final screen is displayed. Click Finish to complete the process.

Figure 150. BluePC Audio Connection Final screen

7. To launch the multimedia application immediately, select the option To launch your

multimedia application immediately, select this box and click Finish. You can run any

audio applications and use Headset to record or play the music. You can also participate in audio

conferencing using Microsoft NetMeeting.

If you have not checked the option as indicated in Step 6, you can connect to the audio device using

the procedure described in section Connect to the Audio Device on page 109.

Using the BluePC Wizard

1. Right-click the Bluetooth icon in the system tray and select the option BluePC Wizard.

Figure 151. BluePC Wizard Menu
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2. The BluePC Wizard screen is displayed.

Figure 152. BluePC Wizard

3. Click Next. A list of options is displayed.

Figure 153. BluePC Wizard options
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4. Select the option Listen to Audio, and click Next.

5. The steps that follow are the same as described in the section Using the BluePC menu on page

104.

4.8.2 Connect to the Audio Device

After you have created an audio gateway, you can connect to the audio device.

1. Right-click the Bluetooth icon in the system tray and select the audio device.

You can run any audio applications and use Headset to record or play the music. You can also

participate in audio conferencing using Microsoft NetMeeting. Once you have completed using the

headset, you can disconnect it. To do so, right-click the Bluetooth icon in the system tray, and select

the option Listen to Audio -> Disconnect.

2. 
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Chapter 5 Troubleshooting BluePC

This section gives solutions to some of the common problems that you may face while using BluePC

and is divided into the following section:

•  Installation

•  Post Installation

•  Locate Bluetooth Devices

•  Connect to services

•  File Transfer

•  Exchange Business Cards

•  Network Access

•  Printing Information

•  Listening to Music

Installation

Problem Solution

Unable to start the installation. If you have downloaded the installation file, the

downloaded file could be corrupted. Download the file

again, and verify the size of the downloaded file against

the size mentioned in the release notes.

The installation appears to be hanging Check whether the Digital Signature Verification dialog

has been masked by the installation screen. Move the

installation screen, and click Continue Anyway in the

dialog to proceed with the installation.

Post Installation

The Bluetooth icon in the system tray is

not active (gray in color)

This could be because BluePC is unable to recognize the

Bluetooth device. Plug out and plug in the device slowly

until it is recognized.

Check whether
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•  The Bluetooth device has been plugged in. If it

has not, plug it in.

•  The Bluetooth device has been plugged in

properly. If it has not been plugged in properly,

plug it out and plug it in again. Note that, on

Windows ME as soon as the Bluetooth device is

plugged in the Multimedia Properties window is

displayed along with the BluePC Startup

window. You should first click OK in the

Multimedia Properties window, and then close the

BluePC startup screen.

Plug-in the Bluetooth device and restart the system. If the

problem still persists, contact Support.

On Windows 2000/XP you need to check whether you

have administrator privileges to the system.

After rebooting the system, the

Bluetooth devices icon is not displayed

in the desktop.

On Windows 98, the NDIS driver initialization takes

anywhere between 30 to 60 seconds. Until this is done you

may not see the Bluetooth icon in the system tray.

This is because BluePC has not been installed properly.

Uninstall and install BluePC again.

Locate Bluetooth Devices

An explore operation consistently fails. Check whether the Bluetooth device has been plugged in

properly. Plug it out and plug in the device again.

The device that you want to locate is

not getting displayed when you

perform an explore.

•  This is because the device discovery duration is too

short. Right-click the Bluetooth icon in the system

tray, and select the Preferences option. Select the

Advanced tab. Modify the number of seconds to

search for devices and click OK to save the

information.

•  Check whether the remote device is active.

The Bluetooth-enabled Windows In BluePC Preferences, select the Advance tab. Check the

option Number of Devices to Report. Increase the
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Explorer is not displaying the names of

all the discovered devices.

numbers and repeat the device discovery process.

Connect to services

An Obtain Services operation

performed on a device fails.

•  Check whether the remote device is active.

•  Check whether the Bluetooth device has been plugged

in properly. Plug it out and plug in the device again.

•  If the Obtain Services operation has not been

performed through the Bluetooth Manager, do so.

•  Log off and log in again.

Unable to refresh the devices in

Bluetooth Manager.

Check whether the Bluetooth device has been plugged in

properly. Plug it out and plug in the device again.

Unable to establish a connection with

the remote machine.

Check if the remote device is active.

Remote service not found. The services may have been removed. Refresh the services

list, and rediscover the services.

File Transfer

Unable to copy a file from the remote

machine.

Check whether:

•  A response has been given to the authorization

request on the remote machine.

•  A file with a similar name exists on the client and it

has read-only permissions.

On Windows XP if the shared folder is "C:\Documents

and Settings\\My Documents", you will not be able to

send files to that machine. Change the shared folder and

retry the operation.

Unable to delete a folder on the remote

machine.

Check whether a response has been given to the

authorization request on the remote machine.

Unable to delete a file on the remote

machine.

Check whether a response has been given to the

authorization request on the remote machine.
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Exchange Business Cards

The Send Business Card operation is

failing.

Check whether you have specified a business card to be

sent in your Bluetooth Device Preferences. In the

Services tab, select Business Card Exchange and click

Properties. A business card should be specified in the My

Business Card field.

Check whether the business card that is being sent is a

valid one.

Network Access

Unable to connect to the Internet

through the Dial- up Network

connection

Check whether

•  You have entered the correct ISP number.

•  You have entered the correct user name and

password.

On Windows 98/ME, a direct cable connection and a dial-

up networking connection cannot be run simultaneously.

Disconnect the direct cable connection, if it has been

connected.

On Windows 98/ME, two simultaneous dial-up

networking connections is not possible. Check whether

this is the case and disconnect one of the connections.

On Windows 98/ME, a simultaneous dial-up networking

connection and Personal Area Network is not possible.

Check whether this is the case and disconnect one of the

connections.

Unable to connect to the Internet

through LAN Access

Check whether

•  You have administrator privileges.

•  You have entered the correct user name and

password.

•  The LAN Access Point has the Ethernet cable

connected.
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Unable to transfer data using the LAN

Access gateway

For data transfer using the LAN Access service, the user

who has logged into the system acting as the LAN gateway

should have permissions to access the domain on which

the machine is connected, and administrator privileges on

the machine acting as the LAN access gateway. Only then

will users, who have connected to gateway, be able to

transfer data.

Printing Information

Unable to print information. Check whether

•  The printer has been powered on.

•  The printer has been setup.

•  The printer is available.

Listening to Music

Cannot connect to the headset. Check whether your device is already connected to

another headset.

Unable to hear music through the

headset

•  You may not have accepted the incoming

connection on your headset. Connect to the

headset again, and accept the connection when

you hear the ringing tone on your headset.

Disconnect the headset. And, during the disconnect when

a beep is heard on the headset click the headset to

complete the disconnect operation. Reconnect the

headset.
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Appendix  A Uninstalling BluePC
To uninstall BluePC:

1. Click Start, and select Programs > Impulsesoft > BluePC > Uninstall BluePC.

Figure 154. Uninstall Menu

Figure 155. Uninstall screen 
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2. Click Next to proceed. The Uninstall progress screen is displayed. After BluePC program is

uninstalled, the Finish screen is displayed.

Figure 156. Uninstall Complete

3. You can restart your computer immediately or later. Select the required option, and click Finish

to complete the uninstall process.
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Appendix  B BlueExplore Icons

In BlueExplore, the following icons are used to represent remote devices and services.

Table 1.  List of Icons

Icon Type Description

Device Desktop or Laptop Computer

Device LAN Access Point

Device Mobile Phone

Device Printer

Device Headset

Device/Service Unknown Device or Service

Service Dial-up Networking

Service FAX

Service Network Access

Service Serial Port

Service Audio

 Connected devices are denoted as shown by the figure below:
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Appendix  C Disabling “Digital
Signature Not Found”

1. Right-click My Computer and select Properties. The System Properties property sheet

appears.

Figure 157. Hardware Settings



BluePC User Manual

Appendix 119

2. Click Hardware tab. The System Properties property sheet changes as shown by the figure.

Click the Driver Signing button.

Figure 158. Driver Signing Options

3. Select Ignore-Install all files, regardless of file signature option and then click OK.
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Appendix  D Supported OS,
Profiles, and Protocols

BluePC supports the following Operating System:

•  Microsoft Windows® XP

•  Microsoft Windows® 2000

•  Microsoft Windows® Millennium Edition

•  Microsoft Windows® 98 Second Edition

BluePC currently supports the following Bluetooth Profiles:

•  General Access Profile

•  Service Discovery Application Profile

•  Serial Port Profile

•  Dial-up Networking Profile

•  LAN Access Profile

•  FAX Profile

•  File Transfer Profile

•  Object Push Profile

•  Headset Profile (for UART Transport Layer only)

•  HCRP – Hard Copy Cable Replacement

•  PANU – Personal Area Network

BluePC currently implements the following Bluetooth Protocols:

•  HCI - Host Controller Interface

•  L2CAP - Logical Link Control and Adaptation Protocol

•  RFCOMM - Radio Frequency Communication

•  SDP - Service Discovery Protocol

•  OBEX – Object Exchange
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Appendix  E Regulatory
Information

Exposure to Radio Frequency Radiation

The radiated output power of the USB BlueOpal Adapter (Bluetooth) internal wireless radio is far

below the FCC and Industry Canada radio frequency exposure limits.  Nevertheless, the wireless

radio shall be used in such a manner that the potential for human contact during normal operation is

minimized. The internal wireless radio operates within guidelines found in radio frequency safety

standards and recommendations, which reflect the consensus of the scientific community.

The level of emitted energy emitted is far less than the electromagnetic energy emitted by wireless

devices such as mobile phones. However, the use of wireless radios may be restricted in some

situations or environments, such as aboard airplanes. If you are unsure of restrictions, you are

encouraged to ask for authorization before turning on the wireless radio.

The FCC and Industry Canada has set a general guideline of 20 cm (8 inches) separation between

the device and the body, for use of a wireless device near the body. This device should be used

more than 20 cm (8 inches) from the body when wireless devices are on.

FCC Part 15 Radio Frequency Interference Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two

conditions:

•  This device may not cause harmful interference.

•  This device must accept any interference received, including interference that may cause

undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital

device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable

protection against harmful interference in a residential installation. This equipment generates, uses

and can radiate radio frequency energy and, if not installed and used in accordance with the

instructions, may cause harmful interference to radio communications. However, there is no

guarantee that interference will not occur in a particular installation. If this equipment does cause

harmful interference to radio or television reception, which can be determined by turning the

equipment off and on. The user is encouraged to correct the interference by one or more of the

following measures:
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•  Reorient or relocate the receiving antenna.

•  Increase the separation between the equipment and the receiver.

•  Connect the equipment into an outlet that is on a circuit different from the receiver.

•  Consult the dealer or an experienced radio/TV technician for help.

Industry Canada RSS-210 Radio Compliance Statement

To prevent radio interference to the licensed service, this device must be operated indoors only and

should be kept away from windows to provide maximum shielding.

Pour empêcher le brouillage radioélectrique du service faisant l’object d’un license, cet appareil doit

être utilisé à l’intérieur et loin des fenêtres afin d’assurer un blindage maximal.

Industry Canada ICES-003 Emission Compliance Statement

This Class B digital apparatus meets the requirement of the Canadian Interference-Causing

Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du règlement sur le matériel

brouiller du Canada.

European Radio Approval Information

The USB BlueOpal Adapter is a low power, wireless communication devices, operating in the 2.4

GHz band, intended for home or office use. The power output of this device is well below the RF

exposure limits as set by the European Commission through the R&TTE directive.

The USB BlueOpal Adapter can be operated in:

Austria, Belgium, Denmark, Finland, France, Germany, Greece, Iceland, Ireland, Italy, Liechtenstein,

Luxembourg, the Netherlands, Norway, Portugal, Spain, Sweden, Switzerland and the United

Kingdom.
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Appendix  F Declaration of
Compliance


	Introduction
	Installing BluePC
	System Requirements
	Installing BluePC

	Getting Started
	Accessing BluePC
	Post Installation

	Elements of BluePC
	BluePC Wizard
	Bluetooth-enabled Windows Explorer
	Bluetooth Manager
	BluePC Preferences

	Setup Preferences
	BluePC Preferences Wizard
	General tab
	Services Tab
	Add a File Transfer Service
	Add Business Card Exchange Service
	Add Serial Port Service
	Add Network Access Service
	To remove a service:

	Security Tab
	Advanced Tab


	Using BluePC
	Access the Network
	Locate the Network Access Service
	Using the Bluetooth menu
	Using BluePC Wizard
	Using the Bluetooth-enabled Windows Explorer

	Set up Connection
	To access the connection through the system tray:
	To access the connection through the Bluetooth-enabled explorer:


	Transfer Files
	Using the Transfer File Menu Option
	Send Files
	Receive Files

	Using the Bluetooth-enabled Windows Explorer

	Exchange Business Cards
	Send Business Cards
	Receive Business Cards

	Print Files
	Using BluePC Wizard
	Using Bluetooth-enabled Windows Explorer
	Print to a Standalone Printer
	Setup the Bluetooth-Enabled Printer
	Access the Serial Port Service


	Synchronize PDAs with your PC
	Add a Serial Port Service
	Setup the PDA to use the Serial Port Service
	Synchronize your PDA
	Synchronize your PDA using ActiveSync
	Synchronize your PDA Using Hotsync


	Wireless Conferencing scenario
	Setup the Host Computer
	Set up the Guest Computer
	Use an already setup Wireless Conference Scenario

	Send a Fax
	Listen to Music
	Setup your Computer as a Audio Gateway
	Using the BluePC menu
	Using the BluePC Wizard

	Connect to the Audio Device


	Troubleshooting BluePC
	
	
	Installation
	Exposure to Radio Frequency Radiation
	FCC Part 15 Radio Frequency Interference Statement
	Industry Canada RSS-210 Radio Compliance Statement
	Industry Canada ICES-003 Emission Compliance Statement
	European Radio Approval Information




